Andlisis Inverso de Propiedades del Material 23-1

Analisis Inverso de Propiedades del
Material

Este tutorial demostrara cémo realizar el analisis inverso de las
propiedades del material, al utilizar las caracteristicas del analisis
probabilistico o de sensibilidad en el Slide. Se puede utilizar el analisis
inverso para determinar la resistencia del material en la falla del talud, o
la resistencia del material requerida para alcanzar un factor de
seguridad determinado.

Se puede utilizar el analisis de sensibilidad para el andlisis inverso de
variables individuales, y el andlisis probabilistico para el anélisis inverso
de variables multiples.
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Temas desarrollados:
. Talud con superficie de falla conocida
. Anilisis de sensibilidad
. Analisis probabilistico
. Analisis inverso de resistencia del material

Se puede encontrar el producto terminado de este tutorial en el archivo
de datos Tutorial 23 Analisis Inverso Propiedades del
Material.slim (“Tutorial 23 Back Analysis Material
Properties.slim”). Se puede acceder a todos los archivos del tutorial
instalados con el Slide 6.0, al seleccionar Archivo > Carpetas Recientes>
Carpeta de Tutoriales (“File > Recent Folders > Tutorials Folder”) desde
el menu principal del Slide.

Nota: si usted no estda familiarizado con las opciones del andlisis de
sensibilidad o probabilistico en el Slide, se recomienda que revise primero
los tutoriales del Slide, 8,9, 10y 11.



Modelo (“Model”)
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Inicie el programa Modelo (“Model”) del Slide. Seleccione Archivo >
Carpetas Recientes> Carpeta de Tutoriales (“File > Recent Folders >
Tutorials Folder”) del menu principal del Slide y abra el archivo
Tutorial 23 Analisis Inverso Propiedades del Material.slim
(“Tutorial 23 Back Analysis Material Properties.slim”).

Usted debe ver el siguiente modelo.
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Para este modelo, se asume que ocurre una falla de desplazamiento del
talud. La superficie de la falla existente viene determina mediante la
linea roja mostrada en la figura anterior. La superficie de falla es no
circular y pasa a través de una capa de material débil (material verde).

El material sobre y bajo la capa débil (material amarillo) es
significativamente mas fuerte que la capa débil y tiene las siguientes
propiedades de resistencia: cohesiéon = 17.5 kPa y angulo de fricciéon =
30 grados.

Asignaremos primero las propiedades de resistencia a la capa débil:
cohesion = 5 kPa y el angulo de friccion = 15 grados. Primero,
ejecutemos el andlisis con estas propiedades para ver los resultados.

Computar (“Compute”)

Seleccione la opcién Computar (“Compute”).
Seleccione: Analisis— Computar (“Select: Analysis — Compute”)

Es instantaneo definir el calculo, debido a que sélo hay una superficie
de falla tnica.
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Interpretar (“ Interpret”)

Para visualizar los resultados del analisis:
Seleccione: Anélisis— Interpretar (“Select: Analysis — Interpret”)

Esto iniciara el programa Interpretar (“Interpret”) del Slide. Usted debe
ver lo siguiente.
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Para el método de andlisis Spencer, el factor de seguridad de esta
superficie de falla es 0.99. Esto es consistente con la superficie de falla
existente, ya que el factor de seguridad es aproximadamente 1.

Hemos obtenido este resultado, al utilizar los valores especificos de
cohesién y angulo de friccién para ambos materiales (material fuerte y
capa débil).

En el contenido restante de este tutorial demostraremos como podemos
utilizar el analisis probabilistico o de sensibilidad, para llevar a cabo el
andlisis inverso de las propiedades del material, suponiendo que uno o
mas parametros de resistencia del material son desconocidos.

Analisis de sensibilidad (“ Sensitivity Analysis”)

Regrese al programa Modelo (“Model”) del Slide.

Seleccione Parametros del Proyecto (“Project Settings”) y seleccione la
opcién Estadisticas (“Statistics”) en la ventana de dialogo Parametros del
Proyecto (“Project Settings”). Note que la opcién Analisis de Sensibilidad
(“Sensitivity Analysis”) (casilla de seleccion) ya esta seleccionada.
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Seleccione OK o Cancelar (“Cancel”), ya que no haremos ningin cambio
ahora.

Estadisticas del Material (“ Material Statistics”)

Ahora, seleccione la opcion Materiales (“Materials”) desde el menu
Estadisticas (“Statistics”). Usted vera lo siguiente.

-

:

Material Statistics

# Material Marme = Property Mean Rel. Min Rel. Max
1 | O weak layer Cohesion 5 5 5 | |
2 | O weak layer Phi 15 5 5

BEEEI:

pdd. || Delete | [ Edt. || Coelation. | [ ok |[ Cancsl

[

Para este ejemplo, hemos definido previamente dos variables para un
analisis de sensibilidad:

. Cohesién de la capa débil

. Angulo de friccion de la capa débil

NOTA: los valores medios actualmente definidos de cohesion y angulo de
friccion (5 kPa y 15 grados) resultan en un factor de seguridad de 0.99 para la
superficie de falla determinada. Para este ejemplo, los valores ya fueron
previamente determinados.

Ahora, supongamos que los parametros de resistencia del material de la
capa débil NO son completamente conocidos. Para comenzar,
supongamos que la cohesién es desconocida, pero que el angulo de
friccién es conocido (15 grados). ;Cémo determinaremos el valor de
cohesion de capa débil?
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Al utilizar el andlisis de sensibilidad, y el hecho de que tenemos una
superficie de falla conocida (factor de seguridad = 1), podemos determinar
facilmente un valor de cohesién de la capa débil en la falla.

Primero, cambiemos un poco los nimeros. Dado que suponemos que la
cohesion es desconocida, si este fuera un talud real, nosotros podriamos
predecir inicialmente el rango de valores posibles. En la ventana de
didlogo Estadisticas del Material (“Material Statistics”), ingrese un valor
medio = 10 kPa y los valores relativos minimos y maximos = 10 kPa. Esto

efectivamente variara la cohesiéon entre 0 y 20 kPa para el andlisis de
sensibilidad.

-
Material Statistics P
# Material Name - Property Mean Rel. Min Rel. Max
1 | O weak layer Cohesion 10 10 10
2 | O weak layer Phi 15 5 5
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Seleccione OK en la ventana de dialogo.

Seleccione Computar (“Compute”) y seleccione Interpretar (“Interpret”).
Usted debe ver el siguiente resultado.

Interpretar (“Interpret”)

Note que el factor de seguridad es ahora 1.082. Esto se debe a que hemos
cambiado la cohesién media de 5 kPa a 10 kPa.
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Debido a que todos los parametros de los valores medios son utilizados
para calcular el factor de seguridad deterministico durante un analisis
probabilistico o de sensibilidad, cualquier cambio en los valores medios
afectara el factor de seguridad deterministico.

Ahora, seleccione la opcién Grafico de Sensibilidad (“Sensitivity Plot”)
desde el menu Estadisticas (“Statistics”) o la barra de herramientas.
Asegurese que sélo la casilla de seleccion Cohesién (“Cohesion”) esté
seleccionada y que la casilla de seleccion angulo de friccién se haya dejado
en blanco, tal como se muestra a continuacién.

r ~
Sensitivity Analysis Plot |i|éj
Analyziz Method:
[spencer '] | e Plot |
Data to Plat:

Senzitivity - weak laper : Cohesion (kN/m2)
[T Sensitivity - weak laver : Phi [deg]

[ selectall | [ Clearan |

Seleccione el botén Grafico (“Plot”), usted debe ver el siguiente grafico de
sensibilidad. Como puede observar, se vari6 la cohesién entre 0 y 20 kPa,
y como consecuencia el factor de seguridad cambid.
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weak layer : Cohesion (KN/m2)

Deseamos saber el valor de cohesién, el cual corresponde al factor de
seguridad = 1. Podemos hacer esto como sigue. Haga clic derecho en el
grafico y seleccione Muestrear el Valor Exacto (“Sample Exact Value”)
desde el ment emergente. Ingrese el valor del factor de seguridad = 1, tal
como se muestra a continuacién y seleccione OK.
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El grafico de sensibilidad mostrara el valor exacto de cohesiéon para el
factor de seguridad = 1. Un valor de cohesién de la capa débil = 5.5 kPa,
corresponde al factor de seguridad = 1. Esto asume que todos los
parametros del talud son exactamente conocidos e iguales a sus valores
medios (esto es, para un angulo de friccién =15 grados, la cohesién en la
falla = 5.5 kPa).

= wesk lrye - Cohesion (2

Ahora, supongamos que la cohesiéon es conocida y que el angulo de
friccién es desconocido.

Modelo (“Model”)

Regrese al programa Modelo (“Model”) del Slide. Seleccione Materiales
(“Materials”) desde el menu Estadisticas (“Statistics”) e ingrese los
siguientes valores.
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# Material Name - Property Mean Rel. Min Rel. Max
1 | O weak layer Cohesion 5 5 5
2 | O weak layer Phi 15 10
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Seleccione OK en la ventana de dialogo.

Seleccione Computar (“Compute”) e Interpretar (“Interpret”).

Interpretar (“Interpret”)

Seleccione Grafico de Analisis de Sensibilidad (“Sensitivity Analysis

Plot”) y grafique s6lo el angulo de friccién.

-
Sensitivity Analysis Plot [ 2 [t
Analyziz Method:
[spencer '] | g Plat I
Diata to Plat:

LCancel

Senzitivity - weak laper : Cohesion [kN/m2)
Sensitivity - weak layer : Phi [deg)
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Seleccione el botén Grafico (“Plot”), usted debe ver que el grafico de
sensibilidad con el angulo de friccién varian entre 5 y 25 grados. Haga
clic derecho en el grafico y seleccione Muestrear Valor Exacto (“Sample
Exact Value”), ingrese un factor de seguridad = 1 y seleccione OK.
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Un angulo de friccién = 15.3 grados proporciona un factor de seguridad =
1. Esto asume que todos los otros parametros son iguales a sus valores
medios (esto es, cohesiéon =5 kPa).

Para resumir: se puede utilizar facilmente el analisis de sensibilidad para
el andlisis inverso de variables individuales. Sélo recuerde, cuando usted
visualice un grafico de sensibilidad de una variable individual, se supone
que todos los otros andlisis son constantes e iguales a sus valores medios.
En general, este procedimiento podria requerir algtin ensayo y error, por
ejemplo si el factor de seguridad solicitado no estda dentro del rango de
salida de datos del grafico de sensibilidad, usted debera ajustar el rango
aceptable de valores de la variable y volver a ejecutar el analisis.

Analisis Probabilistico (“Probabilistic Analysis”)

Se puede utilizar la opcién anélisis probabilistico en el Slide para llevar a
cabo el andlisis inverso de dos variables simultaneas. Por ejemplo,
determinar todos los valores posibles de cohesién Y angulo de friccién por
un factor de seguridad especifico.

Regrese al programa Modelo (“Model”) del Slide y seleccione Parametros
del Proyecto (“Project Settings”). Dirijase a la opcién Estadisticas
(“Statistics”) y regrese a la casilla de seleccion Analisis Probabilistico
(“Probabilistic Analysis”). Seleccione OK.
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Estadisticas del Material (“ Material Statistics”)

Seleccione Estadisticas del Material (“Material Statistics”) desde el menu
Estadisticas (“Statistics”). Dado que estamos llevando a cabo el analisis
probabilistico (ademéas del andlisis de sensibilidad), note que hay dos
entradas de datos requeridas para cada variable: Distribucién
(“Distribution”) y Deviacién Estandar (“Standard Deviation”).
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Material Statistics m
# Material Name Property Distribution Mean Std. Dev. Rel. Min Rel. Max
1 | O weak layer Cohesion ~ Uniform 5 5 5
2 | O weak layer Phi ~ Uniform 15 5 5
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Utilizaremos una Distribucién Uniforme (“Uniform Distribution”) para
ambos, cohesiéon y angulo de friccion. Debido a que suponemos que
AMBOS cohesién y angulo de friccion son variables desconocidas, una
distribucién Uniforme (“Uniform”) asegurara que las muestras aleatorias
sean generadas de forma uniforme sobre el rango completo de cada
variable.

Note que para una distribucién Uniforme (“Uniform”), la Deviacién
Estandar (“Standard Deviation”) no es aplicable, y que por lo tanto esta
inhabilitada. Asegtrese de que los valores, medios, minimos y maximos
sean mostrados (cohesidn, 5,5,5 y el angulo de fricciéon 15,5,5). Seleccione
OK.

Seleccione Computar (“Compute”) y luego Interpretar (“Interpret”).

Interpretar (“Interpret”)

Usted debe ver los siguientes resultados. Note que el factor de seguridad
deterministico es aun 0.99. Asimismo, se lista un resumen de resultados
probabilisticos (PF=probabilidad de falla=53.8%, esto es, mas de la mitad
de todos los resultados dan como resultado la falla del talud. Esto es
como se esperaba, ya que la distribucién del factor de seguridad esta
centrada aproximadamente en el valor medio de 1).
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Ahora, seleccione la opcion Grafico de Dispersion (“Scatter Plot”) desde el
menu Estadisticas (“Statistics”).

En la ventana de didlogo Grafico de Dispersién (“Scatter Plot”) haga las
siguientes selecciones. Grafique la Cohesiéon (“Cohesion”) de la capa débil
versus Fi (“Phi”). Seleccione la casilla de selecciéon Resaltar Datos
(“Hilight Data”). Seleccione el Factor de Seguridad (“Factor of Safety”)-
Spencer. Seleccione la opcion Rango (“Range”) y configure un rango de
0.99 a 1.01. Seleccione el botén Grafico (“Plot”).

Scatter Plot l 7 i

Haorizontal Axis:

[weak layer : Cohesion [kM./m2] v]
Wertical fuis:
[weak layer : Phi [deg) VI

Hilight D ata:

[Factor of Safety - spencer VI
nga-: 1me
[ND secondary criteria v]

Factar of Safety - gle/maorgenstem-price

b 0.98 -

Ll Pt [ Cancel ]

Usted debe ver el siguiente grafico de dispersiéon (“Scatter Plot”).

Hilighted Dala = Factor of Sately . spencer Range »=0.00 fo o181 (76 points}
o ry ry s YY" a a 2 . & PR i .‘“‘ & a &
i
fay o, 4oaan s, oa v '™ . OV S .,
& N " s
¥ N % n " " PR .
o s o . :"‘ o, . " Wt . a* “ “os . b ik o4 a
ik .t " g i oa 4 P N T sk
4 s ¥ . N i
- L . & K i Aoa & N A
wx i a ok . Pt PR I ’ '
PR Lt 4 N Y ° st T " N atat s
A A, L, L4 s, . & Ky N A taae s AL YL Y
1 W ahoa “ * N ik &y " - ‘f PR “ .
lagt N . . - Y A A a A ‘: At aka & Y
“a * Loy L PR . " 3 o aha
N . I . . " 14 N
" a n n n n a ik Y & oa " n
o Y & w A ., ta . o, i, L e
E ‘A.P " LA ¥ y » - 4 .l . s a4 a "
. Lo + . .
15 Yy i Attt b A L A aa & by
4. . . P ooty fhas L ta L
" a ag a ooa s % " -
a . aty . i ' P
" N L I . oa et S & 0t
x A 1 n . 4 s 4 i
n N . N Lok as . . ry .
PR S H A a4
e a & 4 Ay P a L a " hy Lad & As &
A i, aa L a g, Pl b ak i . at foatat
wooa b PR N A . ¥ R R RV adt
12 N ioa wg m sy . N . . N
. " A2 N n . L s i
a b4 Y A a an a LA g kg a . . i
N & PO I at . n o L oa . I
n s sa s N 4 & 8 b oa . W
4 e & i oa * 4 a a4 a i - . .
ok . a " A haad . " a2 w s " . 4
B P ‘ I a 2 Yy * i WM Pl il
L] 1 2 3 4 5 L T 2 L] ®
Wy © Coheaion (W)

L0V28TT, aipl , btas.

Dado que elegimos una distribucién Uniforme (“Uniform”) para ambos
Cohesién (“Cohesion”) y Fi (“Phi”), y no utilizamos la Correlacion
(“Correlation”), usted puede observar que las muestras se han generado
de forma uniforme en todo el rango especifico de ambas variables (esto
es, cohesion de 0 a 10 y angulo de friccion de 10 a 20).

Note que los puntos de datos estan resaltados en rojo. Esto representa
pares de cohesion y angulo de friccidn, lo cual resulta en un factor de
seguridad entre 0.99 y 1.01 (como lo especificamos en la ventana de
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dialogo de dispersion).

Para visualizar solo los datos resaltados, haga clic derecho en el grafico y
seleccione Resaltar Sélo Datos (“Hilighted Data Only”) desde el menu
emergente. El grafico debe lucir como sigue

Halightod Data » Factar of Safety - spencer Range =099 1o <101 (75 paints)

o I 2 3 . s & 7 : ] "
wadk layer  Cohesn (R

Correttion Conflicient= 994189, alpha= 152319, Deta= 0454263 (Hilighted Data Only)

Este grafico muestra la relacién entre la cohesién y el angulo de friccion
para un factor de seguridad de aproximadamente 1. Como puede ver, la
relacion es lineal sobre el rango de valores graficados, para este ejemplo.

Los parametros de la linea de mejor ajuste lineal a través de los datos
resaltados, son proporcionados en la parte inferior del grafico. El
parametro alfa es el intercepto -y-, y beta es el talud de la linea. En este
caso:

Angulo de friccién = -0.58 cohesién + 18.2

Usted puede utilizar esta ecuacién para determinar los valores de
cohesiéon y angulo de friccidon sobre este rango de valores. Asimismo,
usted puede hacer esto de forma grafica con el muestrario. Si usted hace
clic derecho sobre el grafico y selecciona Agregar (“Snap”) el muestrario a
la linea (coordenada -x) o (coordenada -y), usted puede graficamente
arrastrar el muestrario a lo largo de la linea con el mouse, y las
coordenadas (cohesidn, fi) se mostraran de forma interactiva, tal como se
muestra.
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Cualquier par de valores de cohesién y angulo de friccién, que caen en
esta linea, deben proporcionarle un factor de seguridad de
aproximadamente 1. Por ejemplo: al utilizar el muestrario, podemos
determinar que el par de datos de cohesién = 2 y angulo de friccion = 17
caen en esta linea. Si usted ingresa estos datos como la resistencia de 14
capa débil y vuelve a ejecutar el andlisis, usted vera que el factor de
seguridad es en efecto =1.

A pesar que la relacién es lineal en este ejemplo, esto no sera siempre el
caso. De acuerdo al rango de valores, las variables graficadas y la
naturaleza de su modelo, un grafico de dispersién podria exhibir
cualquier tipo de relaciéon funcional entre las dos variables.

Se puede utilizar el procedimiento anterior para cualquier rango de
factor de seguridad. Por ejemplo, si usted desea encontrar valores de
cohesién y angulo de friccién, que correspondan a algin otro valor del
factor de seguridad, simplemente delimite un pequefio rango que
encuadre el factor de seguridad (ej. 1.19 a 1.21), al utilizar la opcién
Resaltar Datos (“Hilight Data”) en la ventana de didlogo grafico de
Dispersién (“Scatter”).

Exportar a Excel

Si usted desea realizar un proceso posterior de datos con otras
aplicaciones, usted puede facilmente exportar los datos a Excel. Por
ejemplo, haga clic derecho en grafico de Dispersiéon (“Scatter”) y
seleccione Grafico (“Plot”) en Excel desde el ment desplegable y se
exportard de forma automatica el grafico y los datos al Excel.
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Analisis Inverso de Otras Variables

En este tutorial solo hemos revisado el andlisis inverso de los parametros
de resistencia del material, en particular, la cohesién y angulo de friccion
de un material Mohr-Coulomb.

En el Slide, se pueden definir casi todas las variables en un analisis
probabilistico o de sensibilidad. En este tutorial, se pueden aplicar los
procedimientos descritos a otros parametros de resistencia y modelos de
resistencia (ej. Hoek- Brown o materiales anisétropos) o a cualquier otro
parametro de entrada de datos aleatorio en el Slide (ej. Propiedades de
apoyo). El usuario puede experimentar con las opciones disponibles.

Analisis Inverso (“Back Analysis”’) de Variables
Multiples (“Multiple Variables™)

Los procedimientos del analisis inverso que involucran maéas de dos
variables han sido descritos para problemas de estabilidad de talud. Sin
embargo, esto estd mas alla del alcance de este tutorial. Las futuras
versiones del Slide podrian implementar métodos de anadlisis inversos
para el analisis simultaneo de mas de dos variables.

Esto concluye el tutorial del andlisis inverso de las propiedades del
material. Ahora, usted puede salir del programa.



